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A judge of the Man Booker Prize once admitted that he
had not read any of the chosen novels from cover to cover.
Shocking? Apparently not.
Pierre Bayard, a French literature professor and author of
the surprise bestseller Comment Parler des Livres que l’on
n’a pas Lus (How to Talk About Books One Has Not Read)
says it is possible to “bluff your way through a book you
have never read” especially if the person you’re talking to
also hasn’t read it. Bayard admits that he himself has never
finished reading Ulysses, nor has he ever started Oliver Twist.
His book, originally aimed at Parisian academia, was sold
out almost immediately, reprinted, and is now on bestsellers lists. It appears to be a self-help manual for the literarily
challenged. His goal was to help people avoid feeling guilty
about their failure to read.
His advice on how to talk about a book you have never
read: “Avoid precise details. Put aside rational thought and
let your subconscious express your personal relationship
with the work.” On how to review a book: “Put it in front of
you, close your eyes, and try to perceive what may interest
you about it. Then write about it yourself.”
I find this very amusing — two people having an “informed discussion” on a book like Ulysses without knowing
anything about it. Perhaps Bayard has considered that his
students will use his methods to con him. In the meantime,
I’d rather read my books no matter how long it takes me,
just as long as it’s not Ulysses.
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Program report
January’s general meeting featured a selection
of info-mercials promoting the Toronto branch’s
fabulous seminars. The refreshingly different format
saw five instructors present quick outlines of their
seminars at roundtable discussions. The room
was abuzz with information, questions, interest,
and great enthusiasm. by Gillian Faulkner and
Frederick Rocque

Kathryn Dean,
Copyediting: A
Hands-on Approach

Seminar roundtable discussion
Copy editing: a hands-on
introduction: “Copy editors need a hundred percent knowledge of grammar and to
know how to look up the rest.” Re-assuring
words from Kathryn Dean as she introduced
her two-day seminar “Copy Editing: A Hands-on
Introduction.”
In the few minutes available, Kathryn skipped
through editor and author relationships, the
importance of being diplomatic and encouraging, and the importance of being able to defend any changes made to a manuscript. She
reminded us that the author is baring his or her
soul and that we need to be sensitive to this. We
may find ourselves in receipt of a note similar to
the one sent to The Times Literary Supplement
by Henry James in response to a request to cut
three lines from a five-thousand-word article: “I
have performed the necessary butchery. Here is
the bleeding corpse.” When the bell went we
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were just settling into the niceties of comma
and hyphen use.
Kathryn’s tantalizing outline for her
two-part seminar “Copy Editing: A Hands-on
Introduction” offers “Labour Pains”, “There’s
a Bear in My Truck”, and an excerpt from
Robert Bateman’s thinking like a mountain
scattered among the “It Looks Funny Rule,” etiquette for editors, dusting off the grammar book
sessions, and much, much more. Take Kathryn’s
two-day seminar on April 4 and 11.

Developing a house style: “Editorial
style is a collection of decisions about how
things will be done. House style is a collection of
the above decisions that the particular organization will use.”
I moved around to Elizabeth d’Anjou’s overview of “Developing a House Style.” This seminar
will appeal to freelancers who may be

E

Seminar roundtable discussion

Marian Hebb,
Copyright: What an
Editor Really Needs
to Know

Elizabeth d’Anjou,
Take the Plunge as a
Freelance Editor &
Developing a House
Style

asked to create a style guide for a company that
does not yet have one, and those who find themselves, by default, trying to figure out their own
house style, as they put together annual reports
and similar documents.
Because different organizations have such different needs, Elizabeth will take a general perspective, and will be talking about what needs
to go into the style guide.
Show, don’t just tell, is the gold nugget. People
want to find things quickly, not wade through
a long explanation; so it’s best to be brief and
succinct and give clear examples of everything.
Generally a style guide is in two sections,
alphabetical and categorical, and what needs
to be in it will depend on who will be using it
and what are their skill levels. If there is no
editor on staff, then the guide will need to be
more detailed. Elizabeth briefly discussed how
to get started, sorting out what may and may
not be useful, getting feedback, having a good
system in place, finding an on-staff Style Master
who has the time and organizational backup to
maintain the guide, and getting people to actually use the guide.

Mike Tanner,
Eight-Step Editing

Greg Ioannou,
Estimating is Not a
Science

Elizabeth’s seminar will also cover reference
resources, Canadian style, staff training, knowing when to break the rules, scheduling regular
reviews, and much more, all delivered with energetic style. Take Elizabeth’s seminar on April 24.

Taking the plunge as a freelance
editor: “Freelance work is quite like dating
a different person each week.” Elizabeth
confessed in “Taking the Plunge as a Freelance
Editor.” It takes hard work, and the small things
are important. Being able to adapt to the
requirements of each assignment is a must.
As a freelance editor, she says, “I’ve made
every mistake that it’s possible to make,” and
has learned the hard way. As an instructor,
Elizabeth hopes to help freelance editors “make
fewer mistakes.”
The top five things she wishes she’d known
before starting out as a freelance editor, include
the harsh reality that it’s like starting a business,
and that taxes, overheads and dreaded hidden
expenses have to be factored into the budget;
that most jobs are acquired through networking,
which opens more doors than merely
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Seminar roundtable discussion

knowing your job; and that
a freelance résumé doesn’t serve
the same purpose as a job-seeking résumé, the latter shows you
are potentially a good fit, while
the former highlights relevant
skills that will be key to getting
the assignment.
The best way to deal with the
financial aspect of being
a freelance editor is to “talk to
someone who knows and follow
through. It may not be foolproof,
but it will certainly help you
get started” and on your way to
fame and fortune.
Making an attractive case for
freelancing, Elizabeth noted
that “you can call the shots,
keep your own hours and be your own boss.”
And she should know. Elizabeth’s one-day seminar was on February 17.

Estimating is not a science: Decisions on
what to charge as a freelancer saw Greg Ioannou
offer a wealth of information in “Estimating Is
Not a Science.” Greg said understanding “billable
hours” helps in deciding an estimate. It refers to
the number of hours of work you’ve done, and
for which you can reasonably charge your clients.
“Nearly half of an estimated 1,000 hours can
be lost to ‘overheads’ — time spent on sales,
administration, learning on the job, and so
on.” Deciding an estimate also depends on the
amount you want to earn in a year, how long
your vacation will be and the hours you are willing to work, Greg pointed out.
“Revisit and keep track of the projects, number of pages, difficulty level, tasks performed,
time taken for each task and the hourly rate,”
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Greg advised participants, and added that the
cost could increase significantly depending on
the difficulty level.
“For jobs that are hard to estimate, create
a two-page sample and multiply that by the
anticipated total number of pages and hours of
work, then include 15 percent as a contingency
and for second checking and so on,” Greg
advised.
While Greg prefers to charge by the hour,
rounding off the figure to $5,000 plus but less
than $6,000 is more likely to be acceptable than
an outright $6,000 quote for a job, he added.
Greg rates his clients from A to C, which helps
to better serve his preferred clients. “In category
‘A’ the work flow and pay is good, and there are
barely any complications. In category ‘B’ the
work is good but the work flow is not constant.
Category ‘C’ helps pay the bills but there is
hardly any work flow, and the pay is nothing to
write home about.”

E

Seminar roundtable discussion

Greg reviews his rates every September, and
sometimes increases them. So long as his
clients don’t complain, it continues to be Greg’s
winning strategy!

Eight-step editing: I was caught in meeting-room traffic at the crowded seminar fair and
just about made it to Mike Tanner’s “Eight-Step
Editing.”
Mike highlighted the skills that the best
professional editors use almost intuitively, with
advice to keep copy clean, sharp and crisp and
sentences short. “Get rid of unnecessary words
and phrases, eliminate negatives, activate the
passive voice and lead with strong, relevant
information.
Mike was sharp too. When presented with
a paper cutter for his efforts at the roundtable
discussions, Mike took one look at the blade and
responded with a verbal stab at the presenter:
“What should I do with this, go out and slit my
throat?” Luckily, that drew laughter, not blood.
In observations about a previous seminar,
Mike pointed out that one participant whole-

heartedly endorsed it as “interesting to be among
people who care about editing . . . an empowering
experience.”
Another participant, when asked, “What kind
of writing do you do?” sheepishly confirmed
there was no writing involved. “I don’t do any
writing, but my supervisor told me to attend!”
It takes all types, but Mike and the team of
instructors are looking forward to meeting
more participants who will find it an interesting,
empowering and rewarding experience. Mike’s
seminar is in Kitchener on April 14.

If we were paid by the hour for the wealth of
information served up at the roundtable discussions, the instructors would have gone home
much richer, and incredibly amazed at the
windfall. But this time around their mission was
wealth sharing. For members, the introduction of
the five seminar subjects was free ($5 for guests)
and well worth the investment in time and
money. 
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Executive news

Report from national
At last, some individuals may now present themselves to
employers or clients as officially Certified in Proofreading.
They passed one or both of the certification tests offered
in November 2006, Proofreading and Knowledge of the
Publishing Process.

A

The EAC has launched its French-language Web site,
www.reviseurs.ca to better serve the roughly 10% of members who are francophone. As with the English-language site,
launched twelve months ago, we welcome your feedback.
The dashing Russel Smith, globe columnist and sartorial pundit, will kick off our light-heartedly Bond-themed
Conference ’007: licence to edit, to be held at the Ottawa
Congress Centre from June 1 to 3.

The national executive is holding its quarterly meeting in
Vancouver the first weekend in March.

Alan Yoshioka
Toronto branch representative,
EAC national executive committee
toronto_br_chair@editors.ca
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Your Toronto branch

Meeting schedule and new members information

For your diary pages
Executive meeting

General meeting

Monday, March 12, 2007

Monday, March 26, 2007

6:30 p.m.

6:45 p.m. New members Q & A

EAC ofﬁce, 27 Carlton Street, Suite 502

7:30 p.m. Business meeting

All members welcome
RSVP: Ann Firth, 905 464-6373

8:30 p.m. Program: Decoding
Spoken English

toronto_br_secretary@editors.ca

23 Prince Arthur Avenue
Members free / non-members $5

Welcome! New members
As of February 1, 2007, the Toronto branch had 709 members (363 voting [includes 1 emeritus], 346 qualifying [formerly associate category])
including 19 student members. Seventeen people joined in December,
six allowed their membership to lapse, and three members identiﬁed
themselves as francophone. The new members are:
Pietro Cammalleri

Viviane Kertesz

Eliza Clark

Elspeth L. McFadden

Janice Vici Colman

Sophie Myriam Perrault

Kim Connors

Doreen F. Pitkeathly

Louise Yvonne Edwards

Karen Ranger

Rebecca Marie Enkin

Lana Lyn Terpstra

Clare Ann Hanman

Dina Theleritis

Lindsay Ann Hodder

Patricia Grace Zonta

Andrea Marie Kerr
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Hotline report and registration

Hotline Report

March 2007

Members registered

12

Clients registered

0

Hotline Registration
Clients call to be matched with branch members who
have registered with the Hotline for work.
When you register, please note these guidelines:
If you are listed in the EAC Directory of Editors
(print or online), note any changes to your listing.
If you are not listed in the Directory and have not
previously registered with the Hotline, send your
résumé in Directory or Hotline style. You can find
guidelines to the Directory format at www.editors
.ca/hire/ode/search_tips.html. Hotline style follows
the Directory format. However, you may include as
many interests as you wish and write your profile in
point form.
Please limit your résumé to one page.
If you have registered before, send your résumé
only if it has changed.
Hotline registration begins on the first of each
month. Please contact the branch every month to be
listed again.
Telephone: 416 975–5528 Fax: 416 975–5596
Toronto@editors.ca (.rtf attachment; subject: Hotline)
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March 2007 seminar calendar
8-step
editing

sun

March 2007
mon

tu

wed

th

fri

sat

1 2 3
4 5 6 7 8 9 10
11 12 13 14 15 16 17
18 19 20 21 22 23 24
25 26 27 28 29 30 31

Substantive
Editing —
Rosemary Shipton
10 am to 4 pm

Estimating Is Not
a Science —
Greg Ioannou
7 to 10 pm

Eight-Step Editing—
Elizabeth d’Anjou
9:30 am to 4:30 pm

Editing Technical
Writing —
Riça Night
9 am to 5 pm

Writing and
Editing Advertising,
Sales, and
Marketing Materials
— Paul Lima
9 am to 4:30 pm
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Substantive Editing with Rosemary Shipton — Saturday, March 3; 10 am to 4 pm.
Substantive editing involves shaping and developing the manuscript, the ﬁrst
step in the editing process.
Eight-Step Editing Toronto Oﬀering with Elizabeth d’Anjou — Saturday, March 10;
9:30 am to 4:30 pm. Originally created by Jim Taylor, Eight-Step Editing breaks the
editorial process down into a series of tasks that will improve the readability of
the ﬁnal product. This seminar is for both the new and experienced editor.
Estimating Is Not a Science with Greg Ioannou — Wednesday, March 7;
7 to 10 pm. How much should I charge? How long will a project take? What tasks
am I responsible for? Greg will guide you through diﬀerent methods of estimating
as well as the common pitfalls.
Editing Technical Writing with Riça Night — Saturday, March 17; 9 am to 5 pm.
Riça will provide an overview of the technical editing ﬁeld and demystify some of
the concerns when approaching technical writing.
Writing and Editing Advertising, Sales, and Marketing Materials with Paul Lima —
Thursday, March 22; 9 am to 4:30 pm. Paul will teach the importance of the prewriting process, and get you to write persuasive, eﬀective copy.
To register for these seminars, please visit our Web page or contact the EAC
Toronto branch oﬃce at 416 975-5528.
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Language

rammar food for thought
An editor’s observations on grammar and usage

Missing articles
by Freya Godard

In the study of a foreign language, the student is often
tripped up by the uses of the definite article, but strangely
enough, this little word also poses difficulties in English
for native English speakers, many of whom are inclined
to omit necessary articles.

U

nlike some mistakes, this is almost exclusively
a phenomenon of the written language and of radio and
television news writers. In the careful writer, Bernstein
speculates about the origin of this practice, which he calls an “affectation” and a “journalistic eccentricity,” blaming time magazine for
helping to spread it but not for having invented it.
The kind of omission of the that most resembles the time magazine style is with appositives involving occupations, which are treated
as if they were titles, as in artist Joe Blow, or renowned composer
Ethel Smythe. Even if this omission of the article no longer grates on
many ears, it can cause practical difficulties. If, for example, your style
calls for Prime Minister Martin but the former prime minister, how do
you capitalize former Canadian Prime Minister Martin?
Occasionally the indefinite article is omitted: The Balfours had two
children, daughter Lisa Balfour Bowen and son St. Clair Balfour IV. . . .
All that is needed to turn that sentence into idiomatic English is an
a before daughter and another before son.
Under the influence of this practice, some writers even drop the
possessive adjective, which from a syntactical point of view can be
considered the equivalent of the definite article. Thus a relative of
mine writes in a Christmas letter: Daughter Jill is enjoying
Theodore Bernstein, The Careful Writer: A Modern Guide to
English Usage (New York: Atheneum, 1965), 49–51.
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Grammar food for thought

her new job with the Ontario government, . . . grandson Peter took
his first steps last month, . . . and
so on, through half a dozen other
children and grandchildren. Here,
of course, the word that has been
dropped isn’t the, but my or our.
It isn’t just occupations and
family members that tend to lose
their article: Although there are
significant barriers to this role for
the port of Halifax, there are also
opportunities. Next steps for development of this role are covered
in detail in Brooks et al. (2006). In
this sentence there is no sense in
the omission of the before either
next steps or development.
The most egregious — and
common — of the unidiomatic
omissions of the is before police:
Police say the woman, who did
not require medical treatment, left
the room and talked to a manager, who then called police. Or:
According to police, the teenager
delivered the baby while she was
alone at the home of her mother’s
boyfriend. It’s hard to imagine that
anyone would talk like that — even
on radio or television, anyone
speaking extemporaneously almost
always says the — and yet the omission has become the norm in all
the media.
In the examples above, the omission of the, though idiomatically
wrong, does not obscure the meaning of the sentence. Sometimes,
however, the definite article is
necessary for the meaning: The
biggest trend is just how damaging testimony coming out of the

sponsorship inquiry is feeding into
the already high levels of cynicism
among voters. Until you come to
feeding, you could easily interpret
the phrase beginning with how
to mean how damaging the testimony … is. Without a the before
damaging, the reader has a 50
percent chance of misreading the
sentence and probably having to go
back and start over.
This sentence has a similar
difficulty: There was virtually no
detail about how the Conservatives
would handle many other civic
needs once existing programs
expired. On first reading, once
existing could easily modify needs
(especially since it happened to
fall at the end of a line). Although
the real meaning emerges a little
later, there is never any excuse for
confusing your readers about what
part of speech or what part of the
sentence they are reading. That
confusion would be removed by
the insertion of the before existing.
The following sentence is similarly misleading: Hot last year as
a source of income … these offerings have deeply disappointed
investors, who have seen their
payouts cut and their units plummet in price. . . . Without the before
deeply disappointed investors,
disappointed sounds too much like
an adjective describing investors.
But language has sound as
well as meaning, and one of the
distinctive features of English is
the contrast between stressed
and unstressed syllables. What
the definite article can do in this

regard is prevent the accumulation
of stressed syllables seen in the following example:
There is an argument to be made
that publishers supported through
the Canada Council’s block-grant
program and the Department of
Canadian Heritage’s industrial-support program do owe taxpayers an
accounting of how their money is
being used. The awkward series
of four stressed syllables — do owe
taxpayers — could have been broken up by a the before taxpayers;
in any case, it’s usual to expect the
article before taxpayers.
Bernstein’s defence of the
definite article referred to above
contains many examples of the
omission of the and, like all
his writing, is enlivened by his
perceptive analysis and witty
commentary. 

Freya Godard has been a freelance editor and writer for more than 25 years.
She also does indexing and translating
and has taught many EAC seminars. In
a previous career she taught high school
French and German, adult ESL, and
university-level writing. Freya lives on
Toronto Island. godard@colcomm.ca
416 214-0183, ext. 13
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TekTips
Tips, tricks, and cool Web sites

Try your hand at writing in rhyme.
Rhymezone provides definitions and quotations
for the words and syllables you select. Another
site is Rhymer that gives you rhymes for every
part of a word, not just the last syllable.
www .rhymezone.com and www.rhymer.com
Instant-message from any computer
anywhere to any other instant messaging system
using Meebo, a free Web-based program.
www .meebo.com
To get to your browser’s address field
quickly in Firefox, type Alt D. Use the up arrow
to display previously entered Web addresses.
Ctrl K jumps to the search bar. For more firefox
keystroke combinations, visit http://lesliefranke.com/files/reference/firefoxcheatsheet.html
Find out how many times you used
a certain word in your Microsoft Word document by using the Find and Replace dialogue box.
Press Ctrl H and enter the word in both the Find
What and Replace With boxes. Click Replace All
to get the number of occurrences of the word.
Nothing will be replaced as you are searching for
and replacing the same word
Eliminate your previously misspelled
words in the autofill field of your online search
engine. Type a letter, and any words that start
with that letter will appear in the dropdown list.
Use the up or down arrow to get to the word you
want to remove. In Internet Explorer, press the
Delete key. In Firefox, press the Shift key, then
the Delete key
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Are you a good speller or a bad speller?
Find out by taking one of the quizzes on
www .badspelling.com
Get your text to flow around a photo
that you paste into Microsoft Word, rather than
it being aligned with the text, by clicking Tools
> Options > Edit > Insert/paste pictures. Use the
arrow to display the dropdown list and select the
format you want to use
Convert your audiobooks ripped from
a CD into a recognizable Audiobooks format
on your iTunes or iPod.
Insert the CD into
your computer and select all the tracks on
it. Choose Advanced > Join CD Tracks. This
makes the content a single long track. Go to
iTunes Preferences > Advanced > Importing.
From the pop-up menu choose AAC Encoder.
Choose Custom from the Setting menu. Then
choose 64 kbps from the Stereo Bit Rate pop-up
menu. Click OK. Select the file you want to
convert into an audiobook and choose Advanced
> Convert Selection to AAC. iTunes converts the
tracks. Select the converted file and choose
File > Show. Change the file’s extension from
.m4a to .m4b. Return to iTunes and delete
the track from the iTunes library (don’t move it
to Trash). Drag the .m4b file into iTunes. iTunes
now recognizes it as an audiobook file. Your iPod
will also recognize it as an audiobook file to allow you to adjust its playback speed.

In the news

Toronto branch member passes away
The evening of February 7, the members’ e-mail forum
received the sad news of the passing of longtime EAC
Toronto branch member Gilda Mekler who had died
suddenly that morning at her home in Hamilton.
Gilda wrote generously on the association’s e-mail
list, where her posts were highly valued for their
warmth, humour, and sound editorial sense. She and
her husband, James Deahl, ran a poetry publishing
company.
Gilda leaves behind her husband, two daughters in
high school, her mother, and stepchildren, to whom
we extend our condolences.
Next month’s Edition will feature a memorial page; if
you have any memories of Gilda that you would like to
share, please contact Alan Yoshioka.
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by Jennie Worden

rom
time to time
on the members’ e-mail
forum, freelance members will post
complaints about a difficult client, or a stingy client,
or tell a tale of woe about a client relationship that has become adversarial (e.g., the client refuses to pay, or won’t pay what the editor thought
the work was worth). Freelancers, justifiably, want to know how they can be
compensated for their work, how they can convince the client their

18
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Make the most of your hired guns

hired guns
work is worth what they’re charging, and how
they can recoup their lost time and effort.
Forum participants are often unable to offer
much assistance. In some cases, it becomes clear
that the freelancer was working without
a contract, or that the client simply does not
have the budget to pay for the hours of work
the freelancer put in. Experienced freelancers repeat — for the gazillionth time — the folly
of working without a contract, and remind
everyone of the Standard Freelance Editorial
Agreement.
As someone who hires freelancers, and who
has worked as a freelancer, I hate these stories;
they make me sad. And while I believe that
freelancers need to look after themselves, and,
as business people, ensure that they do not work
for free, I know too that as someone who hires
freelancers, it’s no fun being on the other side
when things go bad. Having sat on both sides of
the desk, I’ve noticed that some clients seem to
have better experiences than others with freelancers, and some freelancers are better to work
with than others.
So, here’s some advice for those who engage
freelancers—whether you are a freelance editor
who is sub-contracting, or you are an inhouse editor looking for help.

Starting off with all the
details
Before you contact
a freelancer, have
the details of the
project clear in
your head, and be

able to provide the freelancer with the following
information:
❚

The size of the project: How many words is
the manuscript? How many pages?

❚

The exciting features the manuscript may
have: Are there references? Footnotes?
How about tables and figures? Captions?
Features? Is it heavy in dialogue?
Statistics?

❚

The scope of the edit: Is it a light copyedit? A heavy copy-edit? Is there any factchecking involved? Has the manuscript
been edited for style? Is a proofread required? Is there a current style sheet? Will
the editor be responsible for querying the
author or will queries go through someone
in-house?

❚

The editor’s responsibilities: What parts of
the book is the editor responsible for? Will
the freelancer receive a complete manuscript, or will it come in batches?

❚

The anticipated dates for the project:
Freelancers have to schedule their workloads, and can run into conflicts when
timelines are unclear.

❚

The deadline.

❚

The budget for this phase of the project.

You should outline these details when you first
get in touch with the freelancer to set up the
work for the project. Then, if any detail changes
before you send the project to the freelancer, let
your freelancer know as soon as you know.
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Timelines slip. Sometimes budgets change.
Schedules need to be modified. We know this.
It’s only fair to let the people who are helping us
know too.

Getting it in writing
Once you have negotiated the details with the
freelancer, prepare a contract. That way the
freelancer doesn’t have to send you the standard freelance editorial agreement. While large
companies often have a contract prepared by
their lawyer or legal department, you can prepare a contract or work agreement that covers
all of the necessary
details. (Hint:
the Standard
Freelance
Editorial
Agreement
makes a pretty
good template,
and you can
re-word it as
required).
A strong agreement
will outline all of the
details I listed above,
with provisions for
ending the relationship if either party is dissatisfied, or re-negotiating details. While you may be
accustomed to the less formal verbal agreement,
having the details of the contract in a written
form serves as a reminder of what you asked the
freelancer to do. When you have a number of
different projects with differing needs, a written
record of which tasks you asked the freelancer to
do can help prevent an embarrassing misunderstanding.
I borrowed a lot of my protocol for dealing
with freelancers from a large publisher, whose
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packages for freelancers include both a contract
and a memo outlining the scope of the project,
the contact information for the author and inhouse team, the style guide of choice, the level
of edit, particular editorial concerns with the
manuscript, and any weird requests (e.g., “this
author has a morbid penchant for semicolons,
and has requested that we leave most of them
alone. Please correct the ridiculous ones; those
that are improperly deployed; and the ones that
defy all logic or sense; but leave any that you possibly can.”)

Checking in early
and often
Another trick I
learned from the
aforementioned
big publisher was
the importance of
the sample chapter.
Send the freelance
editor a sample
chapter with
instructions
to send
it back,
edited, so
that you can look it over. This ensures that you
are happy with the level of edit, and that you and
the editor are editing from the same style guide.
Even the best editors appreciate knowing that
what they’re doing is correct, and whether or not
they need to change anything. In the event that
the freelancer is editing too heavily or too lightly,
or that you simply have a preference that you
neglected to mention, this strategy gives you the
opportunity to find out early on the process and
notify the freelancer.

Make the most of your hired guns

The sample chapter also allows the freelancer
to be sure that it is possible to do the work in the
allotted time and at the budget you have allocated, and to let you know of any potential problems.
When you call or e-mail the freelancer to discuss
the sample chapter, check that he/she is happy
with the manuscript, the fee, and the amount of
time allocated.
If you have reservations about the editing after
you read the sample chapter, mention your concerns to the freelancer. It could be that you were
unclear in stating your preferences, or that you
and the freelancer mean different things by “light
copy edit.” Now, at the beginning of the project,
is the time to resolve any differences in your assessment of what the project needs.
If I am happy with the sample chapter, I generally leave the editor to edit, and await the glorious results. I try to check in midway through the

project, and I ask freelancers to be in touch with
any questions or concerns. If a freelancer does
contact me, I make sure to respond promptly.
If I have misgivings with the sample chapter, I
ask for another sample chapter, just to reassure
myself, and to give the freelancer any additional
guidance. After that, I had better be confident in
the editor’s work, or I need to dissolve the relationship.
In any relationship, both parties are responsible for clearly communicating their needs and
expectations. Nobody wants a client–freelancer
relationship to go sour, nobody wants to pay for
unsatisfactory work, and nobody wants to be that
client—the one discussed on the listserve. 

Jennie Worden is past chair of the Toronto branch.
toronto_br_past_chair@editors.ca
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Networking directory
compiled by Anne Koenig

All events are in Toronto unless otherwise noted.

ART BAR POETRY SERIES
www.artbar.org
Poetry Readings
When: Tuesday, March 6, 13, 20, and 27, 8 p.m.
Where: The Victory Café, 581 Markham Street
(one block west of Bathurst Street, one block south of
Bloor Street)
Cost: Free; however, they pass a hat for voluntary
donations

ATKINSON COLLEGE, YORK UNIVERSITY
www.atkinson.yorku.ca
Canadian Writers in Person Series
Author Reading: Camilla Gibb reads from her work,
Sweetness in the Belly
When: Thursday, March 15, 7 p.m.
Where: Accolade West Building, Room 206,
4700 Keele Street (at Steeles Avenue)
Cost: Free
Contact: Diane Stadnicki at 416-733-2100, ext.
55870 or at dianes@yorku.ca
Canadian Writers in Person Series
Author Reading: Larissa Lai reads from her book,
Salt Fish Girl
When: Thursday, March 29, 7 p.m.
Where: Accolade West Building, Room 206,
4700 Keele Street (at Steeles Avenue)
Cost: Free
Contact: Diane Stadnicki at 416-733-2100, ext.
55870 or at dianes@yorku.ca

BOOK PUBLISHERS’ PROFESSIONAL ASSOCIATION
www.bppa.ca
“A New Era of Marketing and Sales” Panel
When: Monday, March 19, 6:30 p.m.
Where: The Arts and Letters Club, 14 Elm Street
Cost: Free for members, $20 for non-members
Contact: Andrea Battiston at info@bppa.ca to preregister
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CANADIAN AUTHORS ASSOCIATION—TORONTO
BRANCH
www.canauthorstoronto.org
The Nuts and Bolts of Fiction Writing
When: Thursday, March 15, 7-9 p.m.
Where: Northern District Library, 40 Orchard View
Boulevard (one block north of Eglinton Avenue, west of
Yonge Street), Room 200
Cost: Free for members, $5 for guests
Contact: Ben Antao, president, at ben.antao@rogers.
com or phone 416 250-8885

CANADIAN BOOKBINDERS
(CBBAG)

AND

BOOK ARTISTS GUILD

www.cbbag.ca
Lightweight Boxing Workshop
When: Friday, March 2, 6-9 p.m.
Where: CBBAG Bindery, 60 Atlantic Avenue, Suite 112
(near King and Dufferin Streets)
Cost: $40 and a $15 materials fee that is payable to
the instructor
Contact: workshop@cbbag.ca or phone 416 581-1071.
Register online or download application form and send
to address on Web site. Phone registrations are not
accepted
Heavyweight Boxing Workshop
When: Saturday, March 3, 10 a.m.-5 p.m. The
Lightweight Boxing or some bookbinding or box-making
experience is required.
Where: CBBAG Bindery, 60 Atlantic Avenue, Suite 112
(near King and Dufferin Streets)
Cost: $95 and a $30 materials fee that is payable to
the instructor
Contact: workshop@cbbag.ca or phone 416 581-1071.
Register online or download application form and send
to address on Web site. Phone registrations are not
accepted
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Cloth Binding Restoration Workshop
When: Monday, March 12 to Friday, March 16,
9 a.m.-5 p.m. Bookbinding I and II or permission of the
instructor is required.
Where: CBBAG Bindery, 60 Atlantic Avenue, Suite 112
(near King and Dufferin Streets)
Cost: $400 for members, $460 for non-members
which includes a one-year membership payable on
the first workshop only and a $30 materials fee that is
payable to the instructor
Contact: workshop@cbbag.ca or phone 416 581-1071.
Register online or download application form and send
to address on Web site. Phone registrations are not
accepted
Leather Workshop
When: Saturday, March 17 to Sunday, March 18, 10
a.m.-5 p.m.
Where: 24 Castle Frank Crescent
Cost: $160 for members, $220 for non-members
which includes a one-year membership payable on
the first workshop only and a $10 materials fee that is
payable to the instructor
Contact: workshop@cbbag.ca or phone 416 581-1071.
Register online or download application form and send
to address on Web site. Phone registrations are not
accepted
Printing Basics—Lead Ain’t Dead! Workshop
When: Saturday, March 31 to Sunday, April 1,
9 a.m.-5 p.m.
Where: CBBAG Bindery, 60 Atlantic Avenue, Suite 112
(near King and Dufferin Streets)
Cost: $160 for members, $220 for non-members
which includes a one-year membership payable on
the first workshop only and a $25 materials fee that is
payable to the instructor
Contact: workshop@cbbag.ca or phone
416 581-1071. A maximum of six students will be
accepted. Register online or download application form
and send to address on Web site. Phone registrations
are not accepted

CANADIAN FEDERATION OF POETS (CFP)
www.federationofpoets.com
Workshop and Critiquing Group—Oakville Chapter
When: Tuesday, March 6, 7-9 p.m.
Where: Timothy’s World Coffee, 321 Lakeshore Road
East, Oakville (one block east of Trafalgar Road)
Cost: Free for CFP members
Contact: george_arnold@federationofpoets.com
Oakville Open Mic Event
When: Thursday, March 15, 7-9 p.m.
Where: Timothy’s World Coffee, 321 Lakeshore Road
East, Oakville (one block east of Trafalgar Road)
Cost: Free
Contact: george@federationofpoets.com or visit
www.federationofpoets.com/oakville.htm
The Oakville Arts Council’s Poetry Café
When: Sunday, March 18, 2-4 p.m.
Where: Moonshine Café, 137 Kerr Street, Oakville
Cost: $5
Contact: Elka Ruth Enola at ere@sympatico.ca or
phone 905 257-7075 for further information
Ottawa Federation Poetry Café
When: Sunday, March 18, 2-4 p.m.
Where: Royal Oak II downstairs, 161 Laurier Avenue
East, between Cumberland and King Edward Streets,
Ottawa
Cost: Free
Contact: Richard Vallance at 613 744-1048 or visit
www.federationofpoets.com/ottawa.htm
Burlington Federation Burlington Art Centre
(BAC) Event
When: Sunday, March 25, 2-4 p.m.
Where: Burlington Art Centre, 1333 Lakeshore Road,
Burlington
Cost: Free
Contact: the Burlington Art Centre at 905 632-7796
or view www.federationofpoets.com/burlington.htm
Spoken Word
When: Friday, March 30, 8-9:30 p.m.
Where: The Lawrence House Centre for the Arts,
The Walter Peteryschuk Turret Room,
127 Christina Street South, Sarnia
Cost: Free
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Contact: Inantais@rivernet.net or The Lawrence
House at 519 337-0507 for further information

Where: Northrop Frye Hall, Room 205,
73 Queen’s Park Crescent
Cost: Free
Contact: 416 585-4468

CANADIAN INFORMATION PROCESSING SOCIETY
(CIPS)

“Alexander the Great in Medieval and Early
Modern Culture” Conference
When: Thursday, March 8 to Saturday, March 10
Where: Victoria College, University of Toronto,
91 Charles Street West
Cost: $40, $25 for seniors, and $10 for full-time
students
Contact: www.chass.utoronto.ca/medieval/2007_CMS_
Conf to register and for further information

www.cipstoronto.ca
Dinner Meeting: Speaker To Be Announced
When: Thursday, March 8, 5:30 p.m.
Where: The Ontario Club, 5th Floor, Commerce Court
South, 30 Wellington Street West (northeast corner of
Wellington and Bay Streets)
Cost: $39 for members 2 days before or more, $44 for
members at the door, $55 for guests
Contact: Register online only. For enquiries, e-mail
jeffk@cips.ca
Business Continuity Management (BCM) Meeting
When: Thursday, March 15, 6-7:30 p.m.
Where: The Ontario Club, 5th Floor, Commerce Court
South, 30 Wellington Street West (northeast corner of
Wellington and Bay Streets)
Cost: Free for members, $10 for non-members
Contact: Jim Finch at finch@cips.ca or 416 971-9171.
Register online

CANADIAN SOCIETY OF CHILDREN’S AUTHORS,
ILLUSTRATORS AND PERFORMERS (CANSCAIP)
www.canscaip.org
Monthly Meeting
When: Wednesday, March 14, 7:30 p.m.
Where: St. Bonaventure’s Parish Centre, 1300 Leslie
Street, next to the Toronto Botanical Garden at the
corner of Leslie Street and Lawrence Avenue East
Cost: Free
Contact: 416 515-1559 or office@canscaip.org

THE CENTRE FOR REFORMATION & RENAISSANCE
STUDIES (UNIVERSITY OF TORONTO) (CRRS)
www.crrs.ca
«Ludovicho Domenichi’s First Collection of
Women’s Poetry in Italian Literature» Workshop
When: Friday, March 2, 3:30-5 p.m.
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“Biographies in the Seventeenth Century”
Workshop
When: Friday, March 30, 3:30-5 p.m.
Where: Northrop Frye Hall, Room 205, 73 Queen’s
Park Crescent
Cost: Free
Contact: 416 585-4468

EAST END WRITERS’ GROUP
www.samcraw.com
Monthly Writing Critiques
(with guest speakers periodically)
When: Wednesday, March 28, 7-10 p.m.
Where: 1 Gardens Crescent
Cost: Free
Contact: Sharon Crawford at samcraw@interlog.com
and/or see Web site
EDITORS’ ASSOCIATION OF CANADA
www.editors.ca
“Substantive Editing” Seminar
When: Saturday, March 3, 10 a.m.-4 p.m.
(lunch will be provided)
Where: Northrop Frye Hall, Room 119, 73 Queen’s
Park Crescent
Cost: $105 for members, $140 for non-members
Contact: 416 975-5528 or toronto@editors.ca for
more information or to register by phone—only VISA
accepted. If you wish to register by mail or fax, please
download registration form at above Web site
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“Estimating Is Not a Science” Seminar
When: Wednesday, March 7, 7-10 p.m.
Where: Victoria College Building, Room 212,
91 Charles Street West
Cost: $60 for members, $80 for non-members
Contact: 416 975-5528 or toronto@editors.ca for
more information. See above for registration
“Eight-Step Editing” Seminar
When: Saturday, March 10, 9:30 a.m.-4:30 p.m.
(lunch will be provided)
Where: Oakham House, Ryerson University, Oakham
Lounge, 63 Gould Street, at the corner of Church Street
Cost: $125 for members, $165 for non-members
Contact: 416 975-5528 or toronto@editors.ca for
more information. See above for registration
“Editing Technical Writing” Seminar
When: Saturday, March 17, 9 a.m.-5 p.m.
(lunch will be provided)
Where: Northrop Frye Hall, Room 119,
73 Queen’s Park Crescent
Cost: $130 for members, $170 for non-members
Contact: 416 975-5528 or toronto@editors.ca for
more information. See above for registration
“Writing and Editing Advertising, Sales and
Marketing Materials” Seminar
When: Thursday, March 22, 9:30 a.m.-4:30 p.m.
(lunch will be provided)
Where: Lillian H. Smith Library, Room BC,
239 College Street
Cost: $125 for members, $165 for non-members
Contact: 416 975-5528 or toronto@editors.ca for
more information. See above for registration

GARDINER MUSEUM

OF CERAMIC
www.gardinermuseum.on.ca

ART

Marjorie Harris launches her new book, How to
Make a Garden
When: Sunday, March 25, 3:30 p.m.
Where: Gardiner Museum of Ceramic Art,
111 Queen’s Park Crescent
Cost: $40 for members, $50 for non-members
Contact: Register online

GREY BORDERS READING SERIES
www.greyborders.com
Open Mic Night
When: Tuesday, March 13, 7:30 p.m.; however, come
early to sign up
Where: The Merchant Ale House, 98 St. Paul Street,
St. Catharines
Cost: Free
Contact: the above Web site for further information
Poet Monty Reid reads from his latest work,
Crawlspace
When: Monday, March 26, 7:30 p.m.
Where: The Merchant Ale House, 98 St. Paul Street,
St. Catharines
Cost: Free
Contact: the above Web site for further information

HUMBER SCHOOL
ARTS

OF

CREATIVE

AND

PERFORMING

www.creativeandperformingarts.humber.ca
Humber Writers’ Circle Presents: A session with
author Michael Helm and with assessor Janie Yoon,
editor of Key Porter Books
When: Saturday, March 31, 10 a.m.-noon
Where: Humber College, Lakeshore Campus East,
3199 Lake Shore Boulevard West, Building “J”
(south of the Gardiner Expressway, just east of Colonel
Samuel Smith Park Drive)
Cost: $30 cash, payable at the door
Contact: Hilary Higgins at 416 675-6622, ext. 3449,
or hilary.higgins@humber.ca for further information

INTERNATIONAL ASSOCIATION OF BUSINESS COMMUNICATORS—TORONTO CHAPTER (IABC)
toronto.iabc.com
Panel: Thinking of Becoming an Independent
Practitioner?
When: Thursday, March 1, 6:30-8:30 p.m.
Where: Metro Hall, 55 John Street
Cost: $10 for members, $20 for non-members
Contact: Register online.
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Luncheon: The Media Speak Out On How You Can
Get Better Coverage
When: Thursday, March 8, 12-1:30 p.m.
Where: Royal & SunAlliance, main floor,
10 Wellington Street East
Cost: $50 for members, $40 for students, $75
for non-members
Contact: Register online

INTERNATIONAL READINGS
CENTRE

AT

HARBOURFRONT

www.readings.org
Barbara Gowdy reads from her new novel,
Helpless, and Nuruddin Farah reads from his new
novel, Knots
When: Wednesday, March 7, 7:30 p.m.
Where: Brigantine Room, York Quay Centre,
235 Queens Quay West
Cost: $8 or free for members and students with
valid ID
Contact: 416 973-4000 for further information.
Tickets may be purchased by phone, in person, online
or by fax; please see above Web site for details
C.S. Richardson reads from his new book, The End
of the Alphabet, and Andrea MacPherson reads
from her new book, Beyond the Blue
When: Wednesday, March 14, 7:30 p.m.
Where: Brigantine Room, York Quay Centre,
235 Queens Quay West
Cost: $8 or free for members and students with
valid ID
Contact: 416 973-4000 for further information.
Tickets may be purchased by phone, in person, online
or by fax; please see above Web site for details
American political satirist P.J. O’Rourke is
interviewed by Canada AM’s Seamus O’Regan
When: Wednesday, March 21, 7:30 p.m.
Where: Brigantine Room, York Quay Centre,
235 Queens Quay West
Cost: $8 or free for members and students with
valid ID
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Contact: 416 973-4000 for further information.
Tickets may be purchased by phone, in person, online
or by fax; please see above Web site for details
Joel Rose reads from his new book, The Blackest
Bird, and Jen Sookfong Lee reads from her new
book, The End of East
When: Wednesday, March 28, 7:30 p.m.
Where: Brigantine Room, York Quay Centre,
235 Queens Quay West
Cost: $8 or free for members and students with
valid ID
Contact: 416 973-4000 for further information.
Tickets may be purchased by phone, in person, online
or by fax; please see above Web site for details

MAGAZINESCANADA.CA
www.magazinescanada.ca
“Best On Page”: Cocktails and Concepts
When: Thursday, March 1, 5-8 p.m.
Where: Maro, 135 Liberty Street (south of
King Street West, east of Dufferin Street)
Contact: Register online
The Naked Truth About Magazine Advertising
(A half-day seminar open to junior media
planners who’ve been “in the business” less than
one year)
When: Thursday, March 8, 8:30 a.m.-1:30 p.m.
Where: InterContinental Toronto Hotel, Portman
Room, 220 Bloor Street West
Cost: Free
Contact: Register online.

MUNK CENTRE FOR INTERNATIONAL STUDIES,
UNIVERSITY OF TORONTO
www.utoronto.ca/mcis
Soviet Samizdat: A Catalogue of Periodicals
When: Tuesday, March 6, noon-1:30 p.m.
Where: Munk Centre for International Studies,
1 Devonshire Place, 108N, North House (east of
St. George Street, south of Bloor Street West)
Cost: Free; however, please register online
Contact: above Web site to register and for further
information

Networking directory

Lecture and Reading by Thomas Medicus, author
of In Den Augen Meines Großvaters (In My
Grandfather’s Eyes)
When: Thursday, March 8, 12-2 p.m.
Where: Munk Centre for International Studies,
1 Devonshire Place, 108N, North House (east of
St. George Street, south of Bloor Street West)
Cost: Free; however, please register online
Contact: above Web site to register and for further
information

PAGES BOOKS & MAGAZINES
www.pagesbooks.ca
Book Launch: Ron Jeremy launches his porn-industry
autobiography, The (Hardest) Working Man in Showbiz
When: Wednesday, March 14, 7:30-10 p.m.
(doors open at 7 p.m.)
Where: Gladstone Hotel Ballroom,
1214 Queen Street West
Cost: Free
Contact: the above Web site
Emily Schultz, author of Songs for the Dancing
Chicken, and Eye Weekly’s Jason Alexander
discuss filmmaker Werner Herzog
When: Tuesday, March 27, 7:30-10 p.m.
(doors open at 7 p.m.)
Where: Gladstone Hotel Ballroom,
1214 Queen Street West
Cost: Free
Contact: the above Web site

“Introduction to Business Research Tools” Course
When: Friday, March 16, 9 a.m.-4 p.m.
Where: Faculty of Information Studies, University
of Toronto, 140 St. George Street (north of
Spadina Avenue)
Cost: $199
Contact: Register online

PROFESSIONAL WRITERS ASSOCIATION
TORONTO CHAPTER

OF

CANADA—

www.pwactoronto.org
Medical Writing: Making a Healthy Living as
a Medical Writer (Evening Seminar)
When: Thursday, March 22, 7-8:30 p.m.
Where: Northern District Library, 40 Orchard View
Boulevard (one block north of Eglinton Avenue, west of
Yonge Street)
Cost: Free for PWAC members, pay what you can for
guests ($10 suggested)
Contact: PWAC Toronto president, Nate Hendley, at
nhendley@interlog.com for more information

SOCIETY FOR TECHNICAL COMMUNICATION (STC)
www.stctoronto.org
Monthly Meeting: MadCap Flare
When: Tuesday, March 13, 7-9:30 p.m.
Where: Gold Room, North York Memorial Community
Hall, Toronto Public Library, 5110 Yonge Street
Cost: Free for members, $5 for non-members
(first time free)
Contact: Rob Hanna at president@stctoronto.org or
416 221-4113

PROFESSIONAL LEARNING CENTRE, FACULTY OF
INFORMATION STUDIES, UNIVERSITY OF TORONTO
www.plc.fis.utoronto.ca
“Increasing Web Visibility through Search
Engines” Course
When: Friday, March 2 to Saturday, March 3,
9 a.m.-4 p.m. both days
Where: Faculty of Information Studies, University
of Toronto, 140 St. George Street (north of
Spadina Avenue)
Cost: $425
Contact: Register online

TO LIVE

WITH CULTURE
www.livewithculture.ca
Literature for Our Time: An Hour of Talk
and Conversation
When: Canadian poet Ken Babstock discusses his
book, Mean, on Friday, March 23; graphic novelist
Chris Ware discusses his book, Jimmy Corrigan: The
Smartest Kid on Earth, on Friday, March 30
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Where: Isabel Bader Theatre, 93 Charles Street West
Cost: Free
Contact: individual.utoronto.ca/nickmount/
readingseries2006-07.htm for further information

TORONTO CENTRE
TORONTO)

FOR THE

BOOK (UNIVERSITY

OF

www.library.utoronto.ca/tcb
Variations on the Pictorial: The Cartographic
Eye of the Text
When: Thursday, March 8, 4:15 p.m.
Where: Victoria College, VC119,
91 Charles Street West
Cost: Free
Contact: See above Web site

TORONTO PUBLIC LIBRARY
www.torontopubliclibrary.ca
Winter Author Reading Series
Author Readings: Richard Clewes reads from Finding
Lily, and Devyani Saltzman reads from Shooting Water:
A Mother-Daughter Journey and the Making of a Film
When: Thursday, March 1, 7 p.m.
Where: Toronto Reference Library, Elizabeth Beeton
Auditorium, 789 Yonge Street (on the east side of
Yonge Street, one block north of Bloor Street)
Cost: Free
Contact: See above Web site
Feminist Book Discussion Group: The Penelopiad
by Margaret Atwood
When: Sunday, March 4, 1:45-4 p.m.
Where: North York Central Library, 5120 Yonge Street,
Room 1 (on the west side of Yonge Street, north of
Sheppard Avenue)
Cost: Free
Contact: 416 395-5639 for further information
What Do I Read Next? A hands-on group session on
Digging for Historical Fiction
When: Tuesday, March 13, 2-3 p.m.
Where: North York Central Library, 5120 Yonge Street,
Room 2 (on the west side of Yonge Street, north of
Sheppard Avenue)
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Cost: Free; however, you must register
Contact: 416 395-5672 to register
Book Club: Middlesex by Jeffrey Eugenides will be
discussed
When: Tuesday, March 20, 7-8:30 p.m.
Where: North York Central Library, 5120 Yonge Street,
Room 2 (on the west side of Yonge Street, north of
Sheppard Avenue)
Cost: Free; however, you must register
Contact: 416 395-5672 to register
Winter Author Reading Series
Author Readings: Martha Baillie reads from
The Shape I Gave You, and Dennis Bock reads from
The Communist’s Daughter
When: Thursday, March 29, 7 p.m.
Where: Toronto Reference Library, Elizabeth Beeton
Auditorium, 789 Yonge Street (on the east side of
Yonge Street, one block north of Bloor Street)
Cost: Free
Contact: See above Web site
Research Workshop: Researching Canadian birth,
death, and marriage records
When: Friday, March 30, 2:30-4:30 p.m. Classes with
fewer than four participants may be cancelled.
Where: Toronto Reference Library Learning Centre,
789 Yonge Street (on the east side of Yonge Street,
one block north of Bloor Street)
Cost: Free; however, you must register
Contact: 416 393-7209 to register

TORONTO WRITERS’ CENTRE
www.writerscentre.ca
“Independent Fact-Checking: What Writers Need
to Know” Workshop
When: Saturday, March 3, 10 a.m.-noon
Where: Toronto Writers’ Centre, 101 Yorkville Avenue,
Suite 200 (two blocks north of Bloor Street West,
between Avenue Road and Bay Street)
Cost: $25 for members, $35 for non-members
Contact: 416 975-5172 or md@writerscentre.ca
for tickets
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“Constructing Reconstructions” Workshop
When: Saturday, March 17, 10 a.m.-noon
Where: Toronto Writers’ Centre, 101 Yorkville Avenue,
Suite 200 (two blocks north of Bloor Street West,
between Avenue Road and Bay Street)
Cost: $25 for members, $35 for non-members
Contact: 416 975-5172 or md@writerscentre.ca for
tickets

TORONTO WOMEN’S BOOKSTORE (TWB)
www.womensbookstore.com
Popular Feminism Lecture Series: Feminist
Bookstores, Radical Literacy
When: Monday, March 5, 7:30-9 p.m.
Where: Centre for Women’s Studies in Education,
OISE, University of Toronto, 252 Bloor Street West,
Room 12-199 (one block west of St. George Street)
Cost: Free
Contact: http://www.oise.utoronto.ca/cwse/events
.html#PopularFeminism
International Women’s Day Poetry Reading with
Ayanna Black
When: Thursday, March 8, 12-1 p.m.
Where: Centre for Women’s Studies in Education,
OISE, University of Toronto, 252 Bloor Street West,
Room 12-199 (one block west of St. George Street)
Cost: Free
Contact: Pat Doherty at 416 923-6641, ext. 2204 or
pdoherty@oise.utoronto.ca for further information or
view http://www.oise.utoronto.ca/cwse/events.html.

THE WRITERS & EDITORS NETWORK (WEN)
www.wenetwork.org
Breakfast Meeting: Who Owns the Rights to
Your Work?
When: Saturday, March 17, 9-11:30 a.m.
Where: Canadiana Restaurant, Six Points Plaza,
5230 Dundas Street West, Mississauga
Cost: $13 for WEN members, $16 for non-members
Contact: Register online

THE WRITERS’ CIRCLE
(WCDR)

OF

DURHAM REGION

www.wcdr.org
WordPress Workshop
When: Saturday, March 3, 9 a.m.-4 p.m.
Where: Uxbridge Durham College, 2 Campbell Drive,
Uxbridge, ON [See map on above Web site.]
Cost: $100 for members, $110 for non-members
(includes a copy of Learning WordPress Workbook)
Contact: www.wsws.ca/richhelms/?p=146 to register.
The workshop is for a maximum of 18 students
Breakfast Meeting: Children’s and youth novelist
James Gillam
When: Saturday, March 10, 8:30-11 a.m.
Where: Sports Garden Café, Iroquois Park Sports
Centre, at Victoria and Henry Streets, Whitby
Cost: $13 for members, $16 for guests
Contact: Janet Boccone, breakfast coordinator, at
breakfast2006@wcdr.org or 905 686-0211 to preregister by noon of the preceding Wednesday
Write For Your Life! (A Workshop on How to Write
Compelling Memoirs)
When: Saturday, March 31, 10:30 a.m.-4:30 p.m.
Where: Uplands Writing Retreat, 13240 Mast Road,
Port Perry, ON (15-20 minutes’ drive north of Whitby,
ON, north of Port Perry, ON)
Cost: $70 for members, $75 for non-members
Contact: 905 243-4836 or e-mail Sue Edgewood at
edgewood@accglobal.net

WRITERS’ TRUST OF CANADA
www.writerstrust.com
Writers’ Trust Awards
When: Wednesday, March 7
Where: The St. Lawrence Centre for the Arts, the
Jane Mallett Theatre, 27 Front Street East
Cost: To be determined
Contact: Don Oravec at 416 504-8222, ext. 244 or

doravec@writerstrust.com
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Bon mots
The lighter side of life

❝

The work was like peeling an onion. The outer skin
came off with difficulty… but in no time you’d be
down to its innards, tears streaming from your eyes
as more and more beautiful reductions became
possible. — Edward Blishen (1920–1996), English author

❞
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